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1 New Features 

1.1 Graphics: 3D-Viewer 

SCANTRA’s adjacency graph can now be viewed in 3D which is very helpful in complex environments 
such as ships or staircases. In addition, detected planes can be visualised which allows a user to 
interpret the geometry of a captured project without the necessity of having access to the point clouds.  

 

1.2 Graphics: Frame and annotations for groups 

The project tree now features an option to add annotations and comments to groups. This information 
can then be visualised in the graphics which is particularly helpful in large or complex projects to e.g., 
document the status of processing.  
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1.3 Network analysis: Histogram of results  

Absolute and relative frequencies can now be added to the legend of the network analysis. This helps 
the user to get a better understanding of e.g., how tensions are distributed within a network. The 
settings can be found in the network analysis window under “legend”.  

 

1.4 GUI: Automatically creating backups 

A new function allows to quickly create backups. When activated, the current status of the SCANTRA 
database *.scdb and *.ini are added to a zip file. The resulting file receives a time and date stamp in 
addition to the original project name.  

1.5 Graphics: Arrangement of stations in the neighbourhood graph 

This new feature is particularly helful for users that work entirely without pre.orientations that can 
either stem from contemporary scanners or other registration software. Unoriented scans are sorted 
in a grid after import into SCANTRA since no relative positions and orientations among stations are 
known. After a block adjustment was carried out, stations can now be sorted according to their 
computed positions. It is also possible to sort scans by station-ID or their time stamps in a grid. 

 

1.6 Import/Export: Import of vertical axes for e.g. Leica P-series 

Data that was exported from Trimble Realworks or Leica’s P-series scanners feature no explicit 
information about the x and y-rotation of a scan with respect to the earth’s centre of gravity. Yet, both 
manufacturers directly apply rotations as recorded by built-in inclinometers to the exported point 
clouds. Thus, a new option was added to the settings section which allows to consider inclinometer 
readings with zero values.  

http://www.technet-gmbh.com/
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1.7 Graphics: Show image at mouseover event 

Images can now immediately be accessed at mouseover events. The settings can be found under 
Options -> Graphics. This allows the user to quickly establish an understanding of what data she or he 
is looking at.  

 

2 Improvements 

2.1 Block adjustment tab: Set reference stations via keyboard 

Hitting the first letter (or number) of a stations’ ID on the keyboard allows to choose a reference station 
in the block adjustments’ drop-down list. If more letters or numbers are quickly entered, stations with 
a particular ID can be found much quicker.  

E.g. Entering “A + 1 + 2” on your keyboard navigates to all stations whose identifier starts with “A12”.  

2.2 Core: “De-germanised” Plausibility control 

We have introduced a new plausibility control in SCANTRA 3.0 for registering scans without pre-
orientation. While this feature avoided many false matches compared to its predecessors, it 
unfortunately found less matches. Hence, this function was overlooked which now operates less 
pessimistic as thus at the same level as SCANTRA 2.  

2.3 Core: Increased memory of the block adjustment for huge 
projects 

The magic boundary of SCANTRA Pro in terms of project size was about 10000 registrations or ~5000 
stations. If this border was crossed, then the assigned memory for the block adjustments’ numerical 
backbone was exceeded. Since one of our clients has now completed a scanning project with roughly 
13000 scans (thirteen thousand), we have increased the related memory so that projects of this size 
can be optimised in one block adjustment without any nasty transitions between “clusters” - which 
you would have to introduce otherwise.  
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2.4 Core: Read files only once when spheres or planes are detected 

In SCANTRA 3.0 files had to be imported twice when planes and spheres were detected which was time 
consuming. From 3.1 onwards files need to be imported only once and are being internally transferred 
in different data structures among detection processes.  

2.5 Data browsers: Batchwise activation / deactivation of vertical 
axes in the station browser 

The inspector window already allowed to manipulate multiple vertical axes. The same functionality has 
been added to the station browser.  

2.6 Data browsers: Display only active elements in data browsers 

Queries and other operations in the data browsers could only be applied to all entries in SCANTRA 3.0. 
A new function now allows to apply operations only to entities that are active in the project tree. This 
is particularly helpful in large heterogenous projects where for instance relations of lower quality 
should be removed from an indoor part of a project without deleting relations in the outer part.  

 

 

2.7 Data browsers: Reference frame dialogue 

The reference frame dialogue slowed down drastically in larger projects with a few thousand scans. 
This shortcoming has been fixed by re-implementing this dialogue from scratch.  
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2.8 Graphics / Report: Displaying residuals for individual coordinate 
components 

Residuals can now be displayed for individual coordinate components. This helps, for instance, to 
clarify if a locational or a vertical error occurred. This function can be accessed in the inspector 
windows, the local registration window as well as the point identity window by hovering (tool tip text) 
above the residual entry vt respectively v.  

 

Residuals among points are now also given in individual coordinate components in the report.  

2.9 Graphics: Close all open bitmaps 

The graphics window can govern many bitmaps – which is handy. Closing many images is unfortunately 
tedious. Hence, the context menu (in a bitmap’s panel) features a new entry that closes all bitmaps at 
once.  

2.10 Graphics: Create non-existing bitmaps 

If a user tries to open a bitmap that does not exist yet, then the file is created from the related scan.  

2.11 Graphics: Display number of selected entities in status bar 

The number of selected items in the graphics window is now shown in the status bar located at the 
bottom of the graphics window.  

2.12 Graphics: Randomly shifted grid 

When viewing the adjacency graph of unregistered scans, the latter are per default aligned on a regular 
grid. A disadvantage of this illustration is, that overlapping relations are inevitable. Hence, a new 
sorting algorithm can optionally be used that randomly shifts single scans and thus avoids overlapping 
relations.  

2.13 Graphics: Select stations in graphics from the project tree 

Stations can now be selected in the graphics window based on a selection in the project tree.  

2.14 Graphics: Set same view Graphics window and sectional view 

If a user wants to zoom at the same region in the sectional view that was set in the graphics window, 
then this can be achieved by hitting F8 on the keyboard.  

2.15 Graphics: Show horizontal section based on pre-orientations 

Until now it was mandatory to perform a block adjustment before showing horizontal plane sections. 
If external pre-orientations are given this information can be immediately used to view a cross section.  
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2.16 Graphics: Translucent display of selection relations and stations 

The standard graphical interpretation of a selected relation or station were dashed lines or circles. A 
customisable colour (Settings -> Colours) can now be used to superimpose selected entities.  

 

Note that this function is also quite helpful to visualise the outcome of custom queries in the data 
browsers, e.g. show all stations whose vertical axes have been deactivated. 

  

     

 Graphics: Visualising unused local and global points 

After a block adjustment was carried out, the result view in the graphics window displays only points 
which were considered. All other points, local or global ones, were not shown. However, in some cases 
this is quite helpful, for instance to see which points may have caused tensions and were deactivated 
or if some points were not considered, yet. This functionality is now supported once the user switches 
off the result view. 

2.17 GUI: New icons 

The following new icons can be found in the interface 

… Start -> Project -> Change invalid scan file paths: Allows to assign new paths to moved files. 

… Start -> Project -> Home button: Opens the windows explorer at project directory level. 

… Start -> Detection … Detect geometric primitives of interest (planes, spheres).  

   Start -> Project … Auto backup, see section 1.4. 

 … Vertical tool bar -> 3D … Switches between 2D and 3D viewing mode. 

2.18 Import / Export: Export colour from Z+F scanners 

Z+F data that features colour information from their internal cameras can now be optionally exported.  
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2.19 Import/Export: Updated PointCab Origins 4 interface 

It is now possible to import several PointCab projects. After registration in SCANTRA all individual 
projects can be updated.  

2.20 Import/Export: Vertical axes and existing registrations 

This feature existed before the release of SCANTRA 3.0 and was simply left out of the interface. Since it 
is still a frequently used function, we have re-introduced it again in version 3.1.  

2.21 Invalid paths dialogue: Improved speed 

Changing invalid paths may have required more time than expected in the past, particularly when 
assigning locations on a data server. A new dialogue was implemented that operates much faster.  

2.22 Matchmaker: Automatically increase point identifier 

When creating new points in the Matchmaker, the numerical part of the identifier will now 
incrementally increase.  

2.23 Matchmaker: Font colour in identity list 

Entries of identical points and / or planes were coloured as in the graphics part of the Matchmaker. 
Colourblind people hence found it hard to visually interpret the entry list. This issue was solved by 
tinting the font black and introducing signatures for points and planes in the corresponding colour of 
the graphics.  

 

2.24 Matchmaker: Highlight matched points in images 

In the Matchmaker's bitmaps, points are now coloured differently depending on their use: 

• Unused points: grey 

• Points that form an identity with other than the showed scan pair: light blue 

• Points that are connected by an identity in the current set of scans: Blue 

Note that the colours are adjustable. 

http://www.technet-gmbh.com/


SCANTRA 3.1 Release Notes 

technet GmbH    www.technet-gmbh.com    11 

 

2.25 Matchmaker: Identity is created after digitisation 

If points are digitised in the Matchmaker, point identities are now automatically formed once a point 
in the second scan is created.  

2.26 Matchmaker: Show quality and automatically accepting pre-
orientations 

If a pairwise registration is created manually, its outcome can now be automatically accepted.  

 

2.27 Network analysis: (De-) activate control tab 

After a block adjustment, the network analysis tab automatically emerges. If this behaviour is not 
desired, it can now be switched off (Options -> Registrations).  

2.28 Network analysis: Visibility of selected relations 

If the network analysis is active and the “thickness” option is switched on for relations, then relations 
are hatched in the graphics window.  
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2.29 Options: Add prefixes for point identifiers 

In projects where externally matched points are used, problems can arise if point identifiers are 
ambiguous. To solve this issue, a station’s ID can be used as a prefix for detected spherical targets (see 
Settings -> Detection).  

2.30 Options: Load and set default or factory settings 

The dialogue “Options” was updated:  

• The button on the right of “Cancel” was renamed to “Load standard values”. This button will 
retrieve standard values that a user has defined by ticking the “Apply settings as standard” box 
before closing this dialogue. 

• Under the “General” tab a new button was added named “Reset”. Activating this button will 
reset all settings to the factory settings that were defined by the SCANTRA team.  

2.31 Project tree: Accidentally deleting groups, scans or pre-
orientations 

Until now, all scans within and relations connected with a group were deleted if the superior group in 
the project tree was erased. If this folder happened to be the “Tachy” folder (that is created by default), 
which also contains the “Tachy” station, then all imported pre-orientations were also deleted. This 
issue is now addressed by two countermeasures: a) groups can only be deleted if they are empty and 
b) if a station is about to being deleted that is associated with pre-orientations, then a warning 
emerges.  

2.32 Project tree: Selected sphere diameters for groups 

In mixed scanning projects that contain exterior and interior parts, several sphere diameters may be 
used, e.g., 9 cm and 20 cm. The problem is that the runtime notably increases when the small spheres 
are detected in large outdoor scans – where these diameters are not used anyway. In order to solve 
this issue, sphere diameters can now be assigned to individual groups.  
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2.33 Sectional view: Open section for all stations 

If no station is selected in the graphics window Ctrl +I will open the sectional view for all adjusted 
stations. Before this release all stations had to be selected in the graphics. 

2.34 Sectional view: Show Station-ID at mouseover-event in the 
sectional view 

In many cases it is helpful to see which planes from which stations are overlapping or which planes 
cause contradictions. Hence, we have added a mouseover-event which can be activated by holding the 
CTRL-key. Once the mouse is over a certain plane, its related station-ID is shown.  
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3 Bugfixes  

3.1 Core: Block adjustment with a reference frame 

In some cases, the results of a block adjustment with a reference frame were computed with respect 
to a false reference, e.g. a single station. This bug has been fixed.  

3.2 Core: Operations with “bulk”-E57 files 

E57 also supports “bulk” files that contains several scans within a single file. This has led to problems 
in accessing the data. This bug has now been fixed.  

3.3 Core: Problems of the Magnifier 

Some files (mostly E57) have led to issues in performance of the magnifier in the process of digitising 
points. In some cases, the content of the magnifies only contained white pixels in others, the loading 
process died – particularly in single E57 files that contained several scans. This bug has now been fixed.  
Also, parallaxes between image coordinates and the magnifies have been compensated.  

3.4 Data browsers: “Focus on object” entry “lost” 

Right-clicking on an entry in data browsers allows to focus on certain objects. If a user selects more 
than one entry temporarily and then moves back to a single entity, then the “focus” entry vanishes. 
This bug was fixed.  

3.5 Data browsers: Updating or deleting entities were not updated  

Changes that were made in the data browsers were not updated in the graphics window. This issue 
was fixed.  
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3.6 Graphics: Missing update of the graphics window 

The SCANTRA 3 interface allows to switch certain observations on or off. In some cases, the graphics 
window did not update properly while the computation was actually correct. This issue is now fixed.  

3.7 GUI: Missing update when changing between reference station 
and frame 

If a user has switched from selecting a certain reference station to a reference frame, the GUI may 
appeared to be correct however it was not considered in a computation that was started afterwards. 
A workaround was to close and open the project again. This issue is now fixed.  

3.8 GUI: “Lost” icons on ultrawide screens 

If ultrawide screens were used in combination with screen magnifiers (or “uncommon” screen 
settings), the icons of SCANTRA’s toolbars were stacked and thus invisible / inaccessible. These issues 
were fixed. 

3.9 GUI: Reference frame was transferred from one project to 
another 

If a reference frame was created in one project, then closed and a new project was created or opened 
then the list of reference frames under block adjustment contained frames from the previous project. 
This list is now updated once another project is being processed.  

3.10 GUI: Wrong language settings in the station browser and the 
inconsistent file path dialogue 

Despite that the language setting was set to English, the context menu of the station browser showed 
up in German. This issue has been resolved.  

3.11 Import/Export: Option “measuring range” adjustable 

When exporting point clouds, the option “measuring range” computed a buffer around the outer 
stations within the project. The functionality has now been adapted to what the name suggests: points 
that are further away than n metres from a related viewpoint are rejected from the export.  

3.12 Import/Export: PointCab interface – Update standard views 

Once a PointCab-project was updated in SCANTRA and was opened in PointCab again, the user had to 
click the button “Generate standard views” so that the registration parameters would be applied. If 
this step would have been forgotten, the user would have generated deliverables based on an 
outdated project status. Hence, the PointCab-team has implemented a new tag which is set by SCANTRA 
after a *.lsdx file was updated which automatically initiates the aforementioned function.  
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3.13 Import/Export: Point import dialogue  

3.14 The point import contained some inconsistencies which were 
fixed. Hence, this feature now works as it should. Matchmaker: 
Link stations manually failed 

In certain situations, the manual pre-orientation would lead to sigma t values of several hundred 
metres which made it tedious or even impossible to register the scans in question. We have addressed 
this issue by decomposing the adjustment into two stages. The first stage determines rotational 
components, while the second step shifts the point clouds.  

3.15 Matchmaker: Manual matching was not possible 

If a group in the project tree contained just one scan, then the Matchmaker threw an exception and 
manual matching was not possible. This issue was fixed.  

3.16 Network analysis: Error message “is not a floating-point value” 

In some cases, the default values of the network analysis were removed leading to the error message 
“is not a floating-point value”. This bug has been fixed.  

3.17 Project tree: Drag & Drop  

Selection remains after changing groups after using the drag & drop function in the project tree.  

3.18 Project tree, Matchmaker & graphics: Wrong language setting  

If a user wanted to assign global coordinates to a local point then this can be achieved by right-clicking 
at a point -> edit local point -> link to global system. The last bit was mistakenly not translated in 

Scantra 3.0.  

End of file 
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